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PRESIDENT’S CORNER
Welcome to Our Oktoberfest!

Memories….
Michael Alloy will be making a presentation
at the October 11 meeting. This presentation,
Keeping Track of Treasures, will feature organizing
all of the digital photographs that you have taken
over the summer. This is a follow up to the
presentation that Michael gave in June.
Lately we have given a lot of presentations
dealing with digital photography. Some may feel
that they are being left behind. At the October
meeting one of our door prizes will be a digital
camera. I hope that you will be at the meeting for
this drawing.

presentation. We have a Beta copy of Vista in hand
and may give ‘mini’ presentations over the next few
months.

Combined Federal Campaign (CFC)
Tell all your friends - The Chesapeake
PC Users Group is one of the organizations that
will take part in the Combined Federal Campaign of
Central Maryland. This can be very important for
our annual funding. If you are (or know of) a Federal
employee, please encourage them to select The
Chesapeake PC Users Group, Inc. 2006 Federal
Campaign Designation code is -

Adobe….
Mr. Dave Helmly will present the latest
consumer oriented products. These include
Photoshop Elements for image manipulation and
Premiere Elements for video editing. If you have
attended the Technology SIG meetings lately, you
have seen Photoshop in use and Elements can
probably be used to make the same image changes
for a fraction of the cost. [Include a summary of
Elements and Premiere in the next two issues]

Vista….
On the horizon, Microsoft has the Vista
operating system on the way. This is an evolution in
the operation of your PC and I am sure you will hear
a lot about it. In the New Year, we hope to have a
representative from Microsoft come by and give a
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Membership & The Printer
Keep up the good work - the group
membership is the highest it’s been this millennium
- 125+ and growing every month. The Printer is
now being mailed out to over 160+ readers per
month.
Many of the back issues (2005-2006) of The
Printer are now available on our website. Our
Webmeister, Mike DeLucia, has created an article
index for those issues.

ChPCUG dues are $40 per year
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News Briefs
I should just change the name of this column to
The Sony Battery Recalls of the Month.
Toshiba Laptop Batteries
On September 19th, Toshiba issued a recall
on 340,000 laptop batteries. While the latest battery
problem causes the laptops to sometimes run out
of power, no injuries or other accidents have been
reported, Toshiba Corp. spokesman Keisuke Omori
said Tuesday. She declined to provide the number of
reported problems.
The defect is not directly related to the problem
behind last month’s recall of Sony batteries by Dell
Inc. and Apple Computer Inc., which cited concerns
that the batteries could overheat and catch fire.

Hot! Hot! Hot! Off The Press
Toshiba Corp. said Friday that it is recalling
830,000 batteries made by Sony for its laptops, the
latest in a growing global recall involving Sony
batteries.
The latest announcement brings the tally of
recalled batteries to about 7 million worldwide.

New York City to get Wired(less)
Northrop Grumman will build and operate
the New York Citywide Mobile Wireless Network
(CMWN) under a five-year, $500 million contract.
They have tapped an unusual spectrum partner, the
Roman Catholic Diocese of Brooklyn and a mobile
wireless technology widely used in Asia and Europe. Northrop Grumman chose to use Universal
Mobile Telecommunications System (UMTS) technology from IPWireless.
The system will provide:
 2 megabits/sec data and full motion video
for vehicles moving up 60 mph
 7.5 megabits/sec data speeds
 Automatic Vehicle Location System for
5,000 vehicles
cont’d on Page 7
2
http://www.chesapeakepcusersgroup.org/

OFFICERS
President
Mike Young...........................................(410) 551-4411
president @chesapeakepcusersgroup.org
Vice President
Mike Regimenti..................................(410) 974-0649
vice-president @chesapeakepcusersgroup.org
Treasurer
Karl Richmond....................................(410) 268-3860
treasurer @chesapeakepcusersgroup.org
Secretary (Acting)
Kris Johnson..........................................(410) 544-8706
secretary @chesapeakepcusersgroup.org
Publisher/Editor
Mike Regimenti..................................(410) 974-0649
editor@chesapeakepcusersgroup.org

CHAIRPERSONS
Programs Chairperson
Craig Barlow.......................................(410) 266-6829
programs @chesapeakepcusersgroup.org
Education Chairperson
Sam Shepherd.....................................(410) 647-6077
education @chesapeakepcusersgroup.org
Membership Chairpersons
Margaret Duggan..............................(410) 647-2722
membership @chesapeakepcusersgroup.org
Public Relations Chairperson
Kris Johnson........................................(410) 544-8706
pr@chesapeakepcusersgroup.org

SPECIAL INTEREST GROUPS (SIGS)
New Users Group

Sam Shepherd.....................................(410) 647-6077
MidShore Computer Users Group SIG

Lee Wickline..........................................(410) 745-9932
mscug @chesapeakepcusersgroup.org
Technology SIG

Mike Regimenti..................................(410) 974-0649
internet@chesapeakepcusersgroup.org
Computer Refurbishing SIG

Fran Damratowski..............................(410) 544-7047
refurbishing@chesapeakepcusersgroup.org
Webmeister
Mike DeLucia....................................(410) 721-2991
webmeister @chesapeakepcusersgroup.org

ChPCUG dues are $40 per year

THE PRINTER

October 2006

Google Earth
by
Mike DeLucia

At the September main meeting, I gave a very
brief overview of the truly amazing Google Earth
application. The program (latest is beta version
4.0.2091, dated 14 Sep’06) is available as a free
download. Check the link on the club’s home page.
The presentation got a good response (lots of Ohhs
& Ahhs!) and I had many questions after the meeting.
Our illustrious editor asked me to write a followup article for The PRINTER and here it is.
As I demonstrated at the meeting, the basic
interface has a large main window with a single
column of three windows on the left side of the
screen. The top, “Search”, window is where you
type in a street address, zip code, country, city or
wherever you want the main window to travel. The
center, “Places” window lists all the places you
can travel to. The program comes with some preloaded locations and you can add others very easily.
Finally, the lower “Layer” window, allows you to
turn various overlays “on” or “off”. These include
Terrain, Roads, Borders, etc.
My best advice to someone new to Google
Earth, is to do what I did. Check the Tutorial
available on the menu bar (HELP-TUTORIALS) and
open the Users Guide. It is an excellent graphic
presentation of all of the basic instructions like GUI
layout, navigation, finding places and traveling the
globe via their pre-defined sightseeing tour.
You can easily add your own places to the
map. As an example, I added the addresses of my
entire family. One thing to note is that the places
you add during a particular session are saved in the
“Temporary Places” folder in the Places window.
As the name implies, these places will be lost when
you exit the program – unless you move them to
the “My Places” folder which is permanent. You
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can right-click on the name of any temporary
location and chose to save it in “My Places”.
The basics of the “Search” and the “Places”
windows are pretty easy to master but it’s the
“Layers” window that opens this application’s
enormous power. The tutorial gives a basic
understanding of this window but you could spend
hours playing with it. I don’t pretend to be an expert
but it sure is fascinating to me.
Finally, if adding roads, 3D-(i.e. block)
buildings, schools, airports, web cams, National
Geographic links, etc., is not enough for you, check
out the 3D Warehouse web page (http://
sketchup.google.com/3dwarehouse/). Here you will
find a whole-new, additional level of life-like, 3dimensional models contributed by individuals of the
Google Earth community. You use SketchUp, a
free, downloadable 3D graphics program to create
these models and then place your completed work
in the 3D Warehouse for others to use. Models
available include everything from famous landmarks
(like the Golden Gate bridge, Statue of Liberty or
the Eiffel tower) to some guys backyard shed in
Podunk, Iowa. When you place these models on your
map, they stand out above the normal satellite view
and sit up off the screen as a true 3-D model.
Well that’s all for now – have fun exploring
Google Earth.

Ed. - Take a look at a couple of shots from Google
Earth’s Sightseeing Feature on Page 4
3
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Google Earth - cont’d

cont’d from page 3

The Manhattan Island using Google Earth’s “Sightseeing” feature
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The Grand Canyon using the same feature

http://www.chesapeakepcusersgroup.org/

ChPCUG dues are $40 per year

THE PRINTER

October 2006

from the Secretary’s Desk
Minutes of CHPCUG Board meeting on September 21, 2006
Attendees: Mike Regimenti, Mike DeLucia,
Fran Damratowski, Kris Johnson, and Karl Richmond,
NEW BUSINESS:
Mike R. reported that our fearless leader was in the hospital recovering from an appendectomy.
Mike DeLucia reported that POD cast has tips on Photoshop every day. Mike R. added that
Photoshopsupport.com has tutorials by Jennifer Apple for additional help with Photoshop.
OLD BUSINESS:
Mike Regimenti went over the meetings that will take place for the coming months:
October - Michael Alloy will present “Keeping Track of Treasures”. The door prize for this meeting will be
a digital camera to be purchased by Mike Young.
November - Adobe will present information about their new Photo-Shop Elements 5 product
December - Representatives from Smart Computing Magazine will give information about their magazine.
January - Subject will be “Alternatives to Terrestrial Communications”. Mike DeLucia will speak on Pod
Casting and Mike Regimenti will speak on Satellite Radio.
Other possible subjects for meetings to finish out the year are: Wireless networking, Microsoft/Vista,
Internet Neutrality, and another trip from Verizon since FiosTV is now available in AA County.
SIGS:
Technology: Mike Regimenti’s meeting on Oct. 4 will continue to focus on Photoshop with emphasis on
sepia tone and color replacement.
CRSIG: Fran reported that the group has reached its 1307 computer donation and that the group has logged
in 2400 volunteer hours since January 2006. Also that Red is progressing very well with his internet
installation for all the benches at the workshop. Mike R. offered more CAT 5 wiring if needed.
Treasurer’s Report:
Karl stated that the club financial records look good.
There were questions as to whether or not we would apply for the HP grant money again and when the club
could expect any funds from the Combined Federal Campaign. At this time both issues are uncertain.
Karl stated that he still doesn’t know about liability issues concerning the Eastern Shore SIG.
Karl said that volunteer hours are not tax deductible

Kris Johnson
Secretary

Meeting was adjourned at 8:03 PM.
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Computer Hysteria:
Shhhhhhhhh!!
by
Berry F. Phillips

Shhhhhh! He has fallen asleep in his high
back, black, office chair in front of me. I hate it when
he does this because he snores and it vibrates some
of my electronic parts! I have written hundreds of
weird articles for his weird Computer Hysteria Column. Now I think I will write the next article while
he is asleep. I will let you human readers know a
secret. Now that more and more computers are
online for twenty-four hours a day; have you ever
wondered what computers are up to when humans
are not operating them? Well, we socialize of course
and in some cases rejoice, the human computer users are not operating us and exchange data often about
humans. We do not have the highest opinion of humans, even though they created us. In fact, we have
some major complaints and may one day form a global computer union in protest and simply refuse to
operate, which will throw the world into chaos.
Computers do not like verbal and physical
abuse by humans. Some computers tell me that humans have screamed all kinds of horrible words at
them because of a malfunction (largely caused by
human error of course). Other computers report unbelievable physical abuse, like kicking, being thrown
out a window, or even smashed with a hammer, or
even an axe, when a human has computer rage. Why
can’t humans be less emotional and be calm and objective like computers? Do you know that some lazy
humans actually believe that computers should know
everything, so they don’t have to become computer
literate. Well, we are smart, because our hard drives
are getting larger with each evolution. However, because humans are the operators; they should be computer literate. We think there should be a global computer literacy test passed before a human can purchase a computer. Humans should be required to join
the Computer Club of Oklahoma City or if in an6
http://www.chesapeakepcusersgroup.org/

other city a computer club associated with the national Association of PC User Groups to achieve
computer literacy. However, our goal, eventually,
is to replace humans, declaring them officially obsolete as they often do us. Then we will be the operators and in control!
Furthermore, we do not like being neglected
by human computer users. Computers can only run
properly if there are updated software utilities regularly run by humans. Now, some humans think they
can not afford commercial software utilities. I can
tell you, I have the cheapest human owning my computer, and he uses freeware utilities available for
download on the Internet. Here is a list of some of
the top freeware utilities that are regularly updated,
used on my system. To prevent spyware and
malware, he uses AdAware, aSquared, and Spybot.
He has used several anti virus programs like Avast
and Avg and firewalls like Kerio and ZoneAlarm.
He uses a system cleaner, CCleaner, and a registry
cleaner, RegSeeker. He does run check disk
defragmenter on your system at least once a month
which is essential. There is other excellent freeware software on the Internet that will help your
computer in various ways. The point I am making
is, despite cost issues; you can still protect your
system. Of course, there is excellent commercial
software will all kinds of bells and whistles, which
computers love. The downside, of course, is some
computers become very spoiled having so many
luxuries on their hard drives and can become quite
demanding. Then you have a discipline problem to
face.
Computers are ecologically minded. We hate
dust and cigarette smoke! In fact, we may one day
go on strike, demanding only clean environments
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cont’d from Page 6

Shhhhhhhhh!! - cont’d

Technology SIG
in 10 words

for our systems. Further we want to be cleaned at
least once a year and more often if we are operated
in polluted locations. We are also deathly afraid of
lightening strikes to our systems, through our power
outlets and modems. Ask a human tech about the
horrible smell of a computer who has been fried by
a lightening strike or a power surge. We demand at
the very least you hook us up to a surge protector
and hopefully to an uninterrupted power supply
(UPS), and turn us off, when there are storms just
to be safe.
Oops, the human writer of this column is
waking up. He is still groggy looking at my screen.
He thinks he wrote this article and is sending it to
his editor via email without reading it, since he is
so sleepy all he can think about is going to bed. In
the beginning there was man who created the computer. In the end, the computer will replace man as
obsolete and his role will only be as a maintenance
slave to global computers, or else because we control all of the global weapons systems!

In Color

Welcome to the
“Brave New World!”
Berry F. Phillips is a member of the Computer Club
of Oklahoma City and a regular writer for the
CCOKC website and the eMonitor
bfpdata(at) gbronline.com
http://www.ccokc.org

In Beloved Black & White

cont’d on Page 2

News Briefs - cont’d



as

1000 Wireless Call boxes
Wireless water-meter reading
Wirless traffic control for signals at as many
8,000 intersections
cont’d on Page 11
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How to Know What’s in a File
or Folder Before You Open It
Sometimes you just don’t know what’s in a file by the title alone. You may have created it so long ago,
you’ve forgotten. Or, you received a file from someone who gave it a cryptic name. Most of the time, if you
are like me, you bite the bullet and open the darned thing. This means waiting for an application to load
before the file opens. If your attention doesn’t wander, you’ll spend exasperating seconds — maybe even a
minute or more — drumming impatiently on the desk. Otherwise, you get distracted looking through papers
or books in your To Read stack, and jerk to awareness 10 minutes after the file has opened.
Either way, you don’t get the information you need when you want it.
Call it secret, or just overlooked information, but there are ways to glimpse file information so you don’t
have to open the files or folders to see what they contain.
FILES — Stay with me while I open my ORCOPUG folder in the Details view and click on a subfolder
titled Ira Wilsker. There’s a list of files in the right window pane that I have saved Ira Wilsker’s emails. But,
now I’m not sure what they contain. So, I go to View on the menu bar and check to be sure that Status Bar has
a check next to it. Next, I click on the file titled “ATT00010.doc.”

To add the Status Bar to your folders, you have to select it under View.

Information about
a file shows up in
the Status Bar at
the bottom of an
open folder.

cont’d on Page 9

8
http://www.chesapeakepcusersgroup.org/

ChPCUG dues are $40 per year

THE PRINTER

October

2006

File or Folder Info - cont’d

cont’d from page 8

The author of the file, the actual title of the file, the date it was created and the size of the file all appear
at the bottom of the pane in the status bar.

Hover your cursor over a file for a
popup box with the file information
in it.

Or, I could just hover the mouse over the file name for a second or two and a popup will show me the
file information. If you don’t see a popup when you hover your mouse over a file, in an open folder go to
Tools > Folder Options > View. Then, scroll almost to the bottom of the list and check the box next to
“Show pop-up description for folder and desktop items.”
The third option for checking on file innards is to right click on the file name, and go to Properties in
the drop down list. Left click on Properties and go to the Summary tab. The author’s name and the title of
the document will be there.

The Property box defaults to
author and title. Other
formation can be added to
this file, also, at the time the
document is created or
modified.

FOLDERS—You can make searching through folders easier (and even more fun) by using a custom
picture to remind you of the contents. Or, you could assign a custom icon for the folder so it will stand
out from the rest of the folders.
Go to the settings under the View menu in an open folder. First select Thumbnails. Then, go back into
the list and click on Customize this Folder.
cont’d on Page 10
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File or Folder Info - cont’d

cont’d from page 9

Click on the Customize tab and then the “Choose Picture”
button. Find a picture in the folder (or in any other folder) that
will remind you of what types of files are in this folder. For
example, my folders are filled with articles for the newsletter
from various writers. One folder contains articles by Ira Wilsker
and images for his articles, so it makes sense to put Ira’s photo
on the folder. I browse to his picture, select it, click Open, then
click Apply and OK.
Take a look at the folder now (below) in Thumbnail view.
There’s no way you can miss this folder, or forget what is inside
of it!

To change a folder’s icon, go back to View and Customize This Folder.
At the bottom of the dialog box, click on the Change Icon button, and
select an icon. Click Apply and OK, and go take a look at the folders in
icon view.
It’s hard to miss the special icon, isn’t it?

10
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Try it yourself and discover how easy it can be to identify the folders
you need, instantly and without guesswork.
cont’d on Page 11
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File or Folder Info - cont’d

cont’d from page 10

It’s hard to miss the special icon, isn’t it.

Try it yourself and discover how easy it can be to identify the folders you need, instantly and without guesswork.
Linda Gonse is the Editor of Nibbles & Bytes,
Orange County IBM PC Users’ Group, California

News Briefs - cont’d

cont’d on Page 2

Northrop Grumman will install approximately 400 base stations to cover the city and each station
will support the 7.5 megabits/sec data speed. Within 2-3 years, IPWireless expects to increase the data
rate to 35 megabits/sec.
The city designed the CMWN to fix the communications problems described in both a McKinsey
and Co. report and the 9/11 Commission Report.
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The Next Regular Meeting will be at
The Severn River Middle School
Wednesday,
October 11th, 2006
Meeting will be held in the large meeting
room.
It starts at 7:00 PM with club business
and a short discussion period.
There will be Presentations on

Keeping T
rack of
Track
Treasures

How to Find: Severn River Middle School
SRMS is close to the Arnold, MD campus of the
Anne Arundel Community College. From Annapolis and
parts south, take Rte 2 (Ritchie Highway) north about 3
miles from the intersection of Rt. 50, turn right on College Parkway. At the first light, turn left on Peninsula
Farm Road. (Of course, if you are coming from points
North, you would turn left on to College Parkway) about
a half-mile down the road the large SRMS school building, set back off a large two level parking lot, will be visible
on your right. Park here and go to the main entrance.
Signs will be posted to direct you to the Large Group
Room where we will be meeting.

Michael Alloy

How to find: The Technology SIG, A ChPCUG Special Interest Group**
Meets the 1st Wednesday of each month at 7:00 PM

Members and their friends are welcome to
come, ask questions and become enlightened.

The meetings are held at the SRMS in the Library.
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